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Chapter 1

PGS.OBJ

1.1 Menus: Object

Object:

Style Tags...
Edit or set object styles.

Edit...
Edit the coordinates of the selected object(s).

Information...
View information on an object(s).

Line/Fill...
Set the line/fill style/color for the selected object(s).

Trapping...
Set trapping for the selected object(s).

Text Wrap...
Set text runaround for the selected object(s).

Text Anchor...
Set the position of an anchored object.

Text Frame
Toggle the text frame status of an object.

Duplicate
Duplicate the selected object(s).

Transform...
Transform the selected object(s).

Rotate...
Rotate the selected object(s).
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Move...
Move the selected object(s) a set amount.

Move to Page...
Move selected object(s) to another page.

Align...
Align the selected object(s).

Distribute...
Space out the selected object(s)

Split Paths
Split a composite object into separate paths.

Merge Paths
Merge separate paths into a composite object.

Group
Group selected objects.

Ungroup
Ungroup a group into separate objects.

Lock
Lock selected object(s) in place.

Unlock
Unlock selected object(s).

Make Drawing
Create a new drawing.

Dissolve Drawing
Dissolve a drawing into its component parts.

Add to Drawing
Add selected object(s) to the selected drawing.

Bring to Front
Move selected object(s) to the top of the stack.

Bring Forward
Move selected object(s) one level forward in the stack.

Send to Back
Move selected object(s) to the bottom of the stack.

Send Backward
Move selected object(s) one level forward
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1.2 Object/ Style Tags...

Object/ Style Tags...

This command sets the style tag for the selected objects or the next
objects you draw. It may also be used to create new style tags and to
edit existing ones.

A style tag is a collection of attributes that you can apply to objects
without having to specify individual attributes.

When you the Style Tags command, the Object Style Tags requester will
open. Do not confuse this command with the Type menu’s Style Tags command
which is used to set and edit text style tags.

Style Tags Description

Styles Lists the style tags defined for the current document.
Choose a style tag to set or modify. Choose <no style
tag> to remove the style tag currently set to the text.
Choose the style tag to edit or delete.

New Opens the Object Style requester to create a new style
tag. Shift click on the New gadget to use the attributes
of the selected object for the new style tag

Edit Opens the Object Style requester to edit the style tag
selected in the scrolling list.

Delete Deletes the style tag selected in the scrolling list.
When you delete a style, PageStream opens a requester so
that you can change objects of the selected style to
another style.

Append Opens a file requester to choose a style tag file to add
to the defined styles. Styles can be appended from style
tag files created with the Save gadget, or from
PageStream3 document files. If there are styles in the
appended file with the same names as ones in the current
list, they will be ignored if they have identical
attributes. If they have different attributes, .1 will
be appended to their names.

Save Opens a file requester to enter a filename and path for
the style tag file to save. You can save the styles to a
different file so that they can be appended to another
document when required.

1.3 Object/ Edit...
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Object/ Edit...

This command sets the coordinates of the selected object(s). Do not
confuse this command with the Layout menu’s Edit command, which is used
to set chapter and page options.

The options in the Edit requester vary depending on the type of object
selected; however, there are some options that are common to all objects:

Edit (all objects) Description

Edit Choose the coordinates to edit from the small popup
arrow gadget. You can edit the left, top, right,
bottom, width and height of most objects, but the
type of coordinates is dependent on the type of
object. When you choose a set of coordinates to
edit, the text gadgets to the right of the Edit
popup will change to reflect your selection.

Do not print Check this to stop the object from printing when
the page it is on is printed.

Proportional scaling Check this to maintain the original aspect ratio of
the object when resizing it by dragging its size
handles. When this is checked you cannot resize it
non-proportionally. When this is not checked, you
can resize it proportionally by holding down a
Shift key while dragging a size handle.

The Edit requester will display additional options for some types of
objects. If more than one object is selected when you choose the Edit
command, the Edit Multiple Objects requester will open instead of the
requester specific to the type(s) of objects selected; you can only edit
the bounding box of all the selected objects when more than one is
selected. There are no additional options for multiple objects.

Box Description

Type Choose the corner type. Normal boxes have square
corners. Round boxes have outwardly curved corners,
while scalloped boxes have inwardly curved corners.
Beveled boxes have angled corners and inset have
inwardly squared corners.

Radius Enter the horizontal and vertical radii of the
corners, if a corner type other than Normal is
selected.

Ellipse Description

Type Choose the elliptical shape type. Ellipses are
closed elliptical shapes. Arcs are a portion of an
ellipse’s arc. Pies are similar to arcs, but have
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lines joining the endpoints of the arc to the
center.

Starting/Ending angle Enter the starting and ending angles of the arc for
arcs and pies. 0 degrees is at 3 o’clock, 90
degrees is at 12 o’clock, etc.

Polygon Description

Type Choose the polygon shape type. Normal polygons have
flat sides joining the points. Puffy polygons have
outwardly curved sides, while scalloped polygons
have inwardly curved sides. Wavy polygons have
puffy-scalloped alternating sides and stars have
pointed sides.

Sides Enter the number of sides, from 2 99.

Pre-Rotation Enter the angle at which the shape should be
rotated before being drawn. For example, a
five-sided polygon has a point at the top and a
flat side at the bottom. Pre-rotating it by 180
degrees would reverse this without changing the
object’s actual rotation angle.

Radius Enter the radius of the alternate points as a
percentage of the polygon’s radius, for all polygon
types except normal polygons. Star, puffy,
scalloped and wavy polygons have points that
alternate with the points of the actual sides. For
example, a five-sided star has 5 points, and 4
alternate points inside the polygon shape.

Angle Enter the angle at which the alternate points are
deflected from the actual points, from 0 90
degrees. With 45 degrees deflection, the alternate
points are equally spaced from the actual points.
Increasing or decreasing the deflection moves the
alternate points closer to the actual point on one
side and further from the actual point on the other
side.

Grid Object Description

Type Choose to edit the bounding box coordinates of the
grid object, or its vertices. By changing the
vertices you can distort the grid object for
interesting effects. Vertices are numbered
counterclockwise from the top left vertex.

Cells Enter the number of grid cells in each direction,
from 1 to 99. The number of cells is one less than
the number of lines in the grid.

Grid objects are usually imported from Professional Draw® which has a



PGS.OBJ 6 / 22

grid drawing tool. PageStream does not have a grid drawing tool, but it
can edit grid objects created with Professional Draw. If you use ARexx,
you can draw grid objects in PageStream by sending the following command
to PageStream: ‘settoolmode grid’. You can then draw grid objects until
you select another tool.

Text Object Description

Background Choose an opaque or clear background for the text
object. This is identical to choosing between no
fill and sold white fill with the

Line/Fill
command; the toggle is provided here for

convenience.

Columns, Gutter Enter the number of columns, up to 99, and the
gutter space between them, to place in the text
frame. This is not applicable to frameless text
objects and text shape frames.

If a text frame or a frameless text object is selected when you choose
the Edit command, the Edit Text Object requester will open. If a shape
that has been converted to a text frame with the

Text Frame
command is

selected , the requester applicable to that frame will open.

EPS Object Description

Leave external Check to keep the EPS object external to the
document file. If you toggle this on or off and
PageStream cannot find the original file, a file
requester will open for you to select a file to use.

Frame lock When the frame lock option is off, the EPS
illustration will be scaled with the frame. i.e.,
If you double the size of the EPS object frame, the
EPS illustration will be doubled in size. When the
frame lock option is off, you can scale the EPS
illustration independently of its frame and set its
offset from the frame.

Scale Enter the scale of the EPS object, independent of
its frame, when the Frame Lock option is off.

Offset Enter the offset of the EPS object from the top
left corner of its frame, when the Frame Lock
option is off.

Drawing Description

Leave external Check to keep the drawing external to the document
file. If you toggle this off and PageStream cannot
find the original file, a file requester will open
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for you to select a file to use.

Frame lock When the frame lock option is off, the drawing will
be scaled with the frame. i.e., If you double the
size of the drawing frame, the drawing will be
doubled in size. When the frame lock option is off,
you can scale the drawing independently of its
frame and set its offset from the frame.

Scale Enter the scale of the drawing, independent of its
frame, when the Frame Lock option is off.

Offset Enter the offset of the drawing from the top left
corner of its frame, when the Frame Lock option is
off.

Group Description

Frame lock When the frame lock option is off, the group will
be scaled with the frame. i.e., If you double the
size of the group frame, the group will be doubled
in size. When the frame lock option is off, you can
scale the group independently of its frame and set
its offset from the frame.

Scale Enter the scale of the group, independent of its
frame, when the Frame Lock option is off.

Offset Enter the offset of the group from the top left
corner of its frame, when the Frame Lock option is
off.

Compound Object Description

Frame lock When the frame lock option is off, the complex
object will be scaled with the frame. i.e., If you
double the size of the complex object frame, the
complex object will be doubled in size. When the
frame lock option is off, you can scale the complex
object independently of its frame and set its
offset from the frame.

Scale Enter the scale of the complex object, independent
of its frame, when the Frame Lock option is off.

Offset Enter the offset of the complex object from the top
left corner of its frame, when the Frame Lock
option is off.

Compound objects are usually imported from Professional Draw® in which
they are created with its Make Compound Object command. This is similar
to PageStream’s

Merge Paths
command, except that the resulting object

retains the original object types without conversion to paths. PageStream
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does not have an equivalent menu command, but it can edit compound
objects created with Professional Draw. If you use ARexx, you can create
compound objects in PageStream by using the following command to
PageStream when two or more objects are selected: ‘createcompound’. Use
‘dissolvecompound’ to break a selected compound object into is component
parts.

Bitmap Picture Description

Frame lock When the frame lock option is off, the picture will
be scaled with the frame. i.e., If you double the
size of the picture frame, the picture will be
doubled in size. When the frame lock option is off,
you can scale the picture independently of its
frame and set its offset from the frame.

Scale Enter the scale of the picture, independent of its
frame, when the Frame Lock option is off.

Offset Enter the offset of the picture from the top left
corner of its frame, when the Frame Lock option is
off.

Resolution Enter the resolution of the picture. This changes
the aspect ratio and scale of the picture within
its frame.

Fencing Opens the Edit Picture Fence requester to change
the fence of the picture. This option is used for
irregular text wrap and cropping.

Screen Opens the Edit Screen requester to set the screen
angle and frequency for the picture. This option
allows you to override the angle and frequency of
the page for the selected picture.

Use the Edit Picture Fence requester to change a picture’s fence. A fence
is a path which matches the shape of a picture’s subject and inside which
the picture is cropped. This can be created only for pictures with white
backgrounds because PageStream generates the path around the non-white
parts of the picture.

Edit Picture Fence Description

Fence path Choose how to create the fence path. Any option
other than Frame will create a path around the
picture subject.

Clip to fence Click to crop the picture to its subject so that
the background of the picture will not obscure text
behind the picture.

Use the Edit Screen requester to change the screen angle and frequency of
a picture. This option is not applicable to non-PostScript printers.

An optimized screen for all documents can be chosen from the PPD
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(PostScript Printer Description) file for your printer with the Printing
settings command. This default screen can be overridden for individual
pictures with the Edit Screen requester. This requester can also be
opened by choosing the Screen gadget in the

Line/Fill
requester.

Edit Screen Description

Plate Choose the plate to edit. Spot colors will use the
values set for Black.

Type Choose the spot function, or pattern of the screen.
The default pattern varies depending on the
PostScript device. (Most printers use a dot
pattern.) PageStream’s screen types are: dot, line,
donut, triangle and propeller.

Frequency Click to toggle off the default value, and then
enter the screen frequency for the plate.

Type Click to toggle off the default value, and then
enter the screen angle for the plate.

1.4 Object/ Information...

Object/ Information...

This command displays information about the selected object. The type of
information shown depends on the object type. Information is not provided
for shapes and paths.

When you choose the Information command, the Object Information requester
will open if information can be displayed for the selected object.

Information Description

Name Enter a name for the object.

Description Enter a description of up to 255 characters for the object.

Type Shows the object type.

Size Shows the object size.

Filename If the object is external, this shows the object’s filepath.

1.5 Object/ Line/Fill...

Object/ Line/Fill...

This command sets the line, fill and color of the selected objects or the
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next objects you draw.

Note that the Object menu’s Line/Fill command is used to set the
attributes of objects, not text, while the Type menu’s Line/Fill command
is used to text the attributes for text in a text object.

When you choose the Line/Fill command, Line/Fill requester will open.
This requester is identical to that opened by the Type menu’s Line/Fill
command.

Line/Fill Description (for the Type and
Object Line/Fill requesters)

Line Check to set the line stroke. If this is unchecked, the
object or text will not be stroked. Text should not be
stroked unless you want to use a different color or pattern
for the stroke.

Fill Check to set the fill. If this is unchecked, the object or
text will not be filled.

Screen Opens the Edit Screen to set the angle, frequency and type
of the halftone screen. See below.

Line Options Description

Number Enter the number of line strokes, from 0 and 5, and press
the Tab or Return key to make the change. If you enter 0
the popup gadget will be blank; this is equivalent to
unchecking the Line option. If you enter a number greater
than 1, choose which stroke’s attributes to set from the
popup beside the text gadget. You can choose each stroke
and set its attributes before clicking on Ok.

Offset Enter the offset of the stroke from the path of the text or
object. Positive values offset the stroke outwards from the
path, whereas negative values inset the stroke. This is
useful for offseting multiple strokes to create frames and
special effects, and is easier-to-use than creating
multiple objects.

Color Choose the stroke color from those defined for the
document, and enter the percentage of the color to use into
the associated text gadget. Click on the associated
question mark gadget when a color name or <As Is> is
selected to open the Define Colors requesterthis allows you
to create a new color or edit an existing color. Click on
the question mark when <Custom> is selected to create a
custom color for the current text or objects.

Pattern Click on the question mark gadget next to the pattern
sample to choose a pattern from the Edit Pattern requester.
See below.

Weight Choose the width of the stroke, or choose Custom and enter
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the width of the line into the associated text gadget.
Hairline is defined as 0.3 points.

Dash Choose a dash style for the stroke, or click on the
question mark next to the popup to create a custom dash
style. See below.

Start, End Choose the starting and ending arrowhead styles for the
stroke. Arrowhead styles are applicable only to open paths;
they are never applicable to text. Refer to page 287 of the
manual for examples of each arrowhead style.

Join Choose the join style for the stroke. The join is the shape
of the corner of two line segments and is only applicable
to paths. Miter joins are the default and have sharp
points. Beveled joins are flattened and round joins have
smooth ends. Refer to page 286 of the manual for examples
of each join style. Enter the miter limit into the
associated text gadgetangles smaller than this limit will
be converted automatically to beveled joins.

Cap Choose the end cap style for the stroke. Cap styles are
applicable only to open paths, and to paths with a
non-solid dash style. Butt caps are the default and have
flat ends that do not extend beyond the line ends. Square
and round caps extend beyond the line ends by half the line
weight. Refer to page 286 of the manual for examples of
each cap style.

Fill Options Description

Fill type Choose the type of fill. Basic fills include solid colors,
tints of a color, and patterns. Gradient fills are a
straight blend from one color to another. Radial fills are
a circular blend, outward from the center of the path.
Shape fills are a blend in the shape of the path, outward
from its center.

Color Choose the fill color from those defined for the document,
and enter the percentage of the color to use into the
associated text gadget. Click on the associated question
mark gadget when a color name or <As Is> is selected to
open the Define Colors requesterthis allows you to create a
new color or edit an existing color. Click on the question
mark when <Custom> is selected to open the Edit Color
requester to create a custom color for the current text or
objects.

Pattern Click on the question mark gadget next to the pattern
sample to choose a pattern from the Edit Pattern requester.
See below.

From Choose the beginning fill color for gradient, radial and
shape fills, from those defined for the document, and enter
the percentage of the color to use into the associated text
gadget. Click on the associated question mark gadget when a
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color name or <As Is> is selected to open the Define Colors
requesterthis allows you to create a new color or edit an
existing color. Click on the question mark when <Custom> is
selected to open the Edit Color requester to create a
custom color for the current text or objects.

To Choose the ending fill color for gradient, radial and shape
fills. See From for more information.

Taper Choose the taper type for gradient, radial and shape fills.
This determines how PageStream blends from one color to the
other. Linear tapers are a uniform change in color.
Logarithmic (log) tapers change color logarithmically. Sine
tapers change from the beginning color to the ending color
and back to the beginning color in a sine wave. Saw tapers
are similar to sine tapers except that they are a uniform
change. Enter the taper angle into the associated text
gadget to control the direction of the taper. (Gradient
fills only.)

Offset Enter the horizontal and vertical offset of the beginning
of a radial fill from the center of the path. (Radial fills
only.)

Inset Enter the inset of a shape fill from its path. This sets
how far into the shape the shape gradient will extend. If
it is less than halfway across the path, the remainder will
be filled with the beginning color. You can set the inset
to greater than halfway across the path to create
interesting effects. (Shape fills only.)

Edit Screen Description (PostScript Only)

Plate Choose the process plate for which to set the screen. The
black plate’s settings are used for spot colors.

Type Choose the screen type (spot function) for the selected
plate. The default type varies depending on the PostScript
device, but most printers default to a dot screen. There
are several additional types which are mainly used for
special effects. Refer to page 282 of the manual for
examples of each type.

Frequency Check the associated Default gadget to use the default
frequency for the selected plate. When Default is
unchecked, enter a custom screen frequency into the text
gadget. Frequency is measured in lines per inch and is
limited to the capabilities of your printer.

Angle Check the associated Default gadget to use the default
angle for the selected plate. When Default is unchecked,
enter a custom screen angle into the text gadget. Angle is
measured in degrees.

Edit Pattern Description
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Pattern list Choose a bitmap pattern from the 40 preset patterns. The
first pattern is the default solid fill.

Pattern Use the pattern editor to customize the selected pattern.
Custom patterns are not added to the scrolling list. Click
to toggle a dot in the pattern between white and black. The
black dots are shown as black in the pattern editor, but
the selected fill color will be used for the pattern when
it is applied to an object or text.

Invert Click to change all the white dots to black and vice versa.

Clear Click to change all the dots to white.

Edit Dash Description

Dash Use the dash editor to customize the selected dash style.
Custom dash styles are not added to the Dash popup in the
Line/Fill requester---<Custom> will be selected in the
popup whenever a custom dash style is used.

Invert Click to change all the white dots to black and vice versa.

Clear Click to change all the dots to white.

1.6 Object/ Trapping...

Object/ Trapping...

This command sets trapping values for the selected object(s). Trapping
prevents white gaps between adjacent objects of different spot colors,
and color shifts around objects of different process colors. PageStream
3.0 can trap any object EPS illustrations, which should be trapped before
being imported. Text cannot be trapped in PageStream3.

When you choose the Trapping command, the Trapping requester will open.

Trapping Description

Fill Choose how to trap the fill. Choose Default to use a color’s
default knockout/overprint status as set in the Edit Color
and Plate Control requesters. Choose Knockout or Overprint to
override it for this object. Choose Choke or Spread to trap
the knockout, and enter the amount of choke or spread.

Offset Choose how to trap the stroke. See above for more information
on the options.

1.7 Object/ Text Wrap...
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Object/ Text Wrap...

This command sets how text will flow around the selected object(s). You
can wrap text around the shape of objects or around their bounding boxes.

When you choose the Text Wrap command, the Text Wrap requester will open.

Text Wrap Description

Flow Around Choose to flow around the shape of the object or around its
rectangular bounding box. If the object is a picture, the text will flow
around the shape only if the picture subject is on a solid white
background and if a customized fence has been created.

Text Offset Enter the horizontal and vertical offset of the text from
the graphic.

1 Does not flow text around the graphic.

2 Flows text around the top, bottom and left sides of the
graphic.

3 Flows text around the top, bottom and right sides of the
graphic.

4 Flows text around the top and bottom sides of the graphic.

5 Flows text around all sides of the graphic.

6 Flows text inside the graphic. This is most useful for
flowing text inside a shape.

1.8 Object/ Text Anchor

Object/ Text Anchor

This command changes the position and alignment of objects anchored to
text. The command is available only when an anchored object is selected
with the Object tool.

When you choose the Text Anchor command, the Edit Text Anchor requester
will open.

Edit Text Anchor Description

Text mark Shows the text mark to which the object is
anchored.

Horizontal Relative to Choose whether the object should be aligned
relative to the text mark, to the column or frame
in which it is anchored, or to the page or spread.

Horizontal Alignment Choose whether to align the left (inside), center
or right (outside) edge of the object to the
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column, frame, page or spread. Enter the offset
from the selection into the associated text
gadget.

Vertical Relative to Choose whether the object should be aligned
relative to the text mark, to the column or frame
in which it is anchored, or to the page or spread.

Vertical Alignment Choose whether to align the top, middle or bottom
edge of the object to the column, frame, page or
spread. If you choose Text Mark from the Vertical
Relative To popup, you can align the picture
relative to the baseline of the text mark. Enter
the offset from the selection into the associated
text gadget.

1.9 Object/ Text Frame

Object/ Text Frame

This command toggles the ability of the selected shape or path to hold
text. A checkmark will appear next to the command in the menu when the
selected shape or path can contain text.

Any shape or path can hold text when made into a text frame with this
command. Text frames have one column in them which matches the shape of
the shape or path. After changing a shape or path to a text frame, you
can choose the Text tool and type into it. If you toggle off the ability
of a shape or path to hold text, the text in it will be deleted.

You can even make merged paths into text frames. Drawings and groups
cannot be made into text frames, although shapes and paths in them can be
text frames.

1.10 Object/ Duplicate

Object/ Duplicate

This command makes a copy of the selected object(s) offset from the
original object(s). The copy is made without using the clipboard. After
the copy has appeared, you can move it to the desired position.

The amount the copy is offset is set with the Drawing settings command.

1.11 Object/ Transform...

Object/ Transform...

This command duplicates, rotates and scales the selected objects. It is a
powerful step and repeat function. The effects of the scaling and



PGS.OBJ 16 / 22

rotation are cumulative for each copy made of the objects. You can also
use this command to change just the current object without making copies
by entering zero into the Copies text gadget.

When you choose the Transform command, the Transform requester will open.

Transform Description

Copies Enter the number of copies to make. (0 will
modify the selected object(s) without making
copies.)

Offset Enter the horizontal and vertical offset. The
first copy will be offset these amounts from the
original object. Subsequent copies will be
offset these amounts from the previous copy. The
offset values are applied to objects relative to
the previous object, not to the original object.
This allows you to create spiral effects.

Scale Enter the horizontal and vertical percentages to
scale the object. The first copy will be scaled
these amounts from the original object.
Subsequent copies will be scaled these amounts
from the previous copy. (100% will not scale the
objects.)

Rotate, Slant and Twist Enter the amounts to rotate, slant and twist the
object. The first copy will be rotated by these
amounts relative to the original object.
Subsequent copies will be rotated these amounts
from the previous copy. (0 will not change the
current rotation of the objects.)

1.12 Object/ Rotate...

Object/ Rotate...

This command rotates and skews selected objects about their center. You
can skew objects horizontally (slant) or vertically (twist).

When you choose the Rotate command, the Rotate requester will open.

Rotate Description

Rotate Enter the rotation value in degrees.

Slant Enter the slant (horizontal skew) value in degrees.

Twist Enter the twist (vertical skew) value in degrees.

0, 90, 180, 270 Click to set the rotation value to 90, and slant and
twist to 0.

Horz, Vert Click to flip the object(s) horizontally (add 180 to
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twist) or vertically (add 180 to slant).

1.13 Object/ Move...

Object/ Move...

This command moves the selected objects a specified distance. The command
ignores the grid and guide snap toggles unless you specifically choose to
have the object snapped to the closest grid points and guide positions
after it is moved.

When you choose the Move command, the Move requester will open.

Move Description

Horizontal Enter the horizontal distance to move the
object(s).

Vertical Enter the vertical distance to move the
object(s).

Snap to Grid and Guides Snap the object to the closest grid points and
guide positions after moving the object the
specified distance.

1.14 Object/ Move to Page...

Object/ Move to Page...

This command moves the selected objects to the same position on another
page in the document.

When you choose the Move to Page command, the Move to Page requester will
open.

Move to Page Description

Chapter Choose the document level (document, chapter or subchapter)
to which to move the object(s). This defaults to the
current document level.

Page Enter the page to which to move the object(s).

1.15 Object/ Align...

Object/ Align...

This command aligns selected objects relative to each other, to the page,
or to a point. You can align a single object or as many as you wish, and
you can choose to align the objects horizontally or vertically, to their
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edges or center.

If some of the selected objects are locked and the Align to Objects
option is chosen, PageStream will align the unlocked objects to the
bounding box of the locked objects.

When you choose the Align command, the Align requester will open.

Align Description

Align To Choose how to align the objects.
- Objects Align relative to the bounding box of the

selected objects.
- Page Align relative to the edges of the page.
- Mouse Align relative to a point. After choosing Ok,

crosshairs will appear to select the alignment
point.

- Coordinates Align relative to a point. Enter the coordinates
of the point into the Horizontal and Vertical
gadgets.

1 Align the left edges of the selected objects.

2 Align the vertical axis of the selected objects. (Align the
center horizontally.)

3 Align the right edges of the selected objects.

4 Align the top edges of the selected objects.

5 Align the horizontal axis of the selected objects. (Align the
center vertically.)

6 Align the bottom edges of the selected objects.

1.16 Object/ Distribute...

Object/ Distribute...

This command distributes selected objects within the bounding box
surrounding them, or with a given amount of space between them. You can
choose to distribute the objects relative to their left or right edges,
or to their centers.

When you choose the Distribute command, the Distribute requester will
open.

Distribute Description

Horizontal Distribute the objects horizontally.

Vertical Distribute the objects vertically.

Type Choose how to distribute the objects.
- Bounding box Distributes the objects within their bounding
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box.
- Space Distributes the objects with a specified

spacing. Enter the spacing value into the
text gadget.

Place Choose how to place the objects.
- Left Places the left edges of the objects an equal

distance apart horizontally.
- Center Places the vertical axes of the objects an

equal distance apart horizontally.
- Right Places the right edges of the objects an

equal distance apart horizontally.
- Gap Places the objects with an equal gap between

them horizontally.
- Top Places the top edges of the objects an equal

distance apart vertically.
- Middle Places the horizontal axes of the objects an

equal distance apart vertically.
- Bottom Places the bottom edges of the objects an

equal distance apart vertically.
- Gap Places the objects with an equal gap between

them vertically.

1.17 Object/ Split Paths

Object/ Split Paths

This command splits the selected path into its subpaths, if the path is
made up of subpaths. Each subpath will become a separate object. If the
subpaths overlap, this will change the appearance of the fill because the
overlapping portions will no longer be unfilled.

1.18 Object/ Merge Paths

Object/ Merge Paths

This command converts the selected objects to paths and then joins them
to create a composite pathone path with multiple subpaths. Objects to be
merged must be unlocked and ungrouped. They cannot be drawings, pictures,
EPS objects, or text objects.

The new composite path will take on the attributes of the bottom-most
object selected when the Merge Paths command is selected. The overlapping
portions of a composite path will be unfilled, regardless of the path’s
fill.

1.19 Object/ Group
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Object/ Group

This command combines the selected objects into a group to freeze the
relative positions of the objects and to simplify manipulating them. A
group of objects can be selected, moved, scaled and edited as one object.
The appearance of the individual objects is unchanged when they are
grouped; groups exist only to make editing easier.

Groups can be many levels deep. For example, you could group a number of
groups together as one group, or group objects with another group.

1.20 Object/ Ungroup

Object/ Ungroup

This command ungroups the selected group(s) into their component objects.
Groups within the group will not be ungrouped. Use the Ungroup repeatedly
to ungroup nested groups.

1.21 Object/ Lock

Object/ Lock

This command protects an object from being accidentally modified. Locked
objects cannot be moved, scaled, transformed, or otherwise edited in
PageStream. If you attempt to modify a locked object, a requester will
open to ask you if you want to ignore the lock, unlock the object, or
cancel the action.

Choose the Unlock command to remove the lock from an object.

1.22 Object/ Unlock

Object/ Unlock

This command unlocks the selected objects. Locked objects cannot be
moved, scaled, transformed, or otherwise edited.

1.23 Object/ Make Drawing

Object/ Make Drawing

This command creates a new drawing made up of the selected objects. A
gray border will appear around the bounding box of the drawing to
indicate that a drawing is selected.

After objects have been combined into a drawing, they cannot be edited
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individually. Use the
Dissolve Drawing
command to convert a drawing into

its component parts so that they may be edited.

1.24 Object/ Dissolve Drawing

Object/ Dissolve Drawing

This command dissolves the selected drawings into their component
objects. The name of the drawing and its description will be lost. If the
drawing is external to the document, its objects will become internal
because individual objects cannot be left external.

1.25 Object/ Add to Drawing

Object/ Add to Drawing

This command adds the selected objects to the bottom-most selected
drawing. The objects will become part of the drawing.

1.26 Object/ Bring to Front, Bring Forward

Object/ Bring to Front, Bring Forward

These commands bring the selected objects forward in the object stack on
the page. Objects are placed on the page in a stack; the first object
drawn will be stacked below subsequent objects.

Choose Bring Forward to move the selected objects one level forward in
the stack of the objects on the page. Choose Bring to Front to move the
selected objects to the top of the objects on the page.

Note that if there are objects on the master page, and the master page
objects are set to draw on top of objects on the actual page, then
bringing an object forward will not place it on top of objects on the
master page. Choose Edit » Page to change the stack order of master page
objects.

When you click on a stack of objects, only the top one will be selected.
You can select the bottom object in a stack by holding down the Ctrl key
while clicking.

1.27 Object/ Send to Back
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Object/ Send to Back

These commands move the selected objects backward in the stack order of
objects on the page. The Send Backward command moves the object(s) back
one level in the stack. The Send to Back command moves the object(s) to
the bottom of the stack.

See also
Bring to Front


	PGS.OBJ
	Menus: Object
	Object/ Style Tags...
	Object/ Edit...
	Object/ Information...
	Object/ Line/Fill...
	Object/ Trapping...
	Object/ Text Wrap...
	Object/ Text Anchor
	Object/ Text Frame
	Object/ Duplicate
	Object/ Transform...
	Object/ Rotate...
	Object/ Move...
	Object/ Move to Page...
	Object/ Align...
	Object/ Distribute...
	Object/ Split Paths
	Object/ Merge Paths
	Object/ Group
	Object/ Ungroup
	Object/ Lock
	Object/ Unlock
	Object/ Make Drawing
	Object/ Dissolve Drawing
	Object/ Add to Drawing
	Object/ Bring to Front, Bring Forward
	Object/ Send to Back


